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About the Installation Guide

This guide provides a detailed explanation of how to install windows and web-based
components of defect manager including installation considerations for different options
and configurations.

This chapter will help guide you through the installation process. To install Tiera
Software Defect Manager you need to follow the general steps below:

Review the System Requirements
Review Defect Manager System Installation Approaches
Install Defect Manager

1

2

3

4. Configure a Data Source Name (DSN) to use the Defect Manager

5. Upgrade the existing Defect Manager System (for existing users only)
6

Use Defect Manager Administrator to configure the system

If you are installing the demo, you do not need to perform steps 4-6 to start using the
system. A default configuration is already set up in the database that is supplied as part of
the product demo that does not need to be upgraded or configured.

An Installation Checklist section is provided as a convenient summary outline and guide
to the installation and deployment processes for Defect Manager and its major
components:

e Defect Manager for Windows

e Defect Manager for Web

e E-Tech Support

e Defect Manager Repository Database

Other Defect Manager Guides

The Installation Guide has the following companion guides that provide additional detail
on specific topics for Defect Manager:
= Getting Started Guide
User Guide — Defect Manager for Windows
User Guide — Defect Manager for Web
User Guide — E-Tech Support
Administration Guide
Programmer APl Guide
Glossary
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System Requirements

Before installing Defect Manager it is important that you have met the following
prerequisites:

e At least 100 MB of disk space available for Defect Manager software.
e Windows 2000, Windows XP, Windows Server 2003, Windows ME 98/95

If you are planning on using the Microsoft Visual Source Safe integration, you will need:
e Microsoft Visual Source Safe 6.0

If you are planning on using the web interface capabilities of the product you will need
the following:

e Web Server: Microsoft 11S5.0 or 11S 6.0

e Web Browser: Microsoft Internet Explorer (IE) 5.5 or greater, Mozilla Firefox,
others.

The Defect Manager Repository supports the following database management systems:
Microsoft Access, Microsoft SQL Server, and Oracle databases.

Defect Manager for Windows workstation (Complete Install/User)
e Windows 98/ME/2000/XP
e Hard disk with at least 50 MB available for Defect Manager
e Multi-user configurations, require network access to shared repository database

Defect Manager for Windows server install (Network Install/User)
e Windows 2000/XP/2003 desktop
e Hard disk with at least 10 MB available for Defect Manager
e Network access for shared repository database and application programs

Defect Manger for Web and E-Tech Support (Web Server Install)
e Windows 2000/2003/XP server
Hard disk with at least 50 MB available for Defect Manager
11S 5.0 or greater
Network access for internet/extranet and shared repository database
Workstations with Browser: Microsoft IE 5.5 or greater.

Databases

e Access 97, 2000, 2002

e SQL Server 6.x, 7.x and 2000, 2005

e Oracle 8i, 9i, 10i,11i
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Installed Directory Structure

After you run the setup.exe program, there will be several sub-folders installed under the
folder where you chose to install the Defect Manager.

The sub-folders are described below.

\Attachments — This is the default folder where defect attachments are stored.
For every defect that has an attachment, there will be a sub-folder under
Attachments. By using the Defect Manager Administrator, you can change this
location.

\Bin — This folder holds the product executables for Defect Manager for
Windows. It also contains the online help files.

\Manuals — The documentation suitable for printing is placed here.

\Network Install — The network installer (setup.exe) program is located in this
folder. Just run the setup.exe program from this directory on another user’s
machine in your network and it will install defect manager on the user’s machine.

\Reminders — This is the folder where reminder notifications should be placed.
The sub-directory Log keeps a detail execution log every time the reminders.exe
program runs.

\Reports — This is the folder where reports for the system are placed. Under this
directory there are sub-directories for each supported report engine. The \XML
sub-directory contains the predefined XSLT reports.

\Schema — This folder contains repository initialization SQL scripts.

\Scripts — This is the folder that contains initialization scripts that establish
default codes in the repository when they are run.

\Upgrade — The folder where the update.exe program execution logs are placed.
\POP3Server — The folder where the POP3Server logs are stored.

\MailManagerServer — The folder where the Mail Manager Server logs are
stored.

\Web — All the web-based capabilities for Defect Manager are located in this
directory. The first sub-directory is \defectmgr, which is the root directory for
Active Server Page version of Defect Manager for Web. The second sub-directory
is \defectmgr.net, which is the root directory for Active Server Page .net version
of Defect Manager for Web. The third sub-directory, \ETechSupport, is the root
directory for E-Tech Support system.
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System Installation Approaches

Defect Manager is now available in two different versions and you will have to decide
whether you will be installing Defect Manager for Windows, Defect Manager for Web
or both versions. Since there are several possible ways to install Defect Manager, this
section will describe the different approaches you may select or use in combination.

Defect Manager for Windows is designed to run as a “Client” program in a client/server
environment. As a client program, Defect Manager executes on each user’s workstation
and access a shared repository database. Access to the repository database from client
programs on each workstation is done over the network using ODBC and TCP/IP
communications protocols. An ODBC Data source Name (DNS) object is used, on the
workstation, to establish communications to the repository database.

Defect Manager for Web is designed to run as a “Thin Client” using a web-browser on
the workstation communicating with the web-based Defect Manager application on a web
server platform. Defect Manager is designed to work with web browsers such as
Microsoft Internet Explorer and Mozilla Firefox. Access to the repository database using
web applications occurs between the web-server and the database server so an ODBC
DSN is not needed on a user workstations in this situation.

Also, it is possible for the web-server and the database-server to both reside on the same
computer platform.

E-Tech Support is a web-based application that allows external clients and third-parties
restricted access to the repository database. This web application also operates as a
“Thin Client” using the same principles, described above, as Defect Manager for Web.

Evaluating Defect Manager with the Demo

If you downloaded the demo and are doing a product evaluation for a single user, you do
not need to perform a network install.

When you install the executable components of the Defect Manager for Windows
demonstration on your workstation, the ODBC Data Source Definition (DSN) is
automatically configured to reference the demo repository using Microsoft Access.

If you prefer to evaluate Defect Manager for Windows on a server platform to support
several users, refer to the next section: Installing Defect Manager for Windows.

If you wish to install the Defect Manager for Web and/or E-Tech Support demonstration
on your web-server platform, follow the directions in sections: Installing Defect
Manager for Web.

Installing Defect Manager for Windows

If you are going to use the Defect Manager for Windows version, the best way to deploy
the product is to install it on a server platform. In this configuration, all the users will
share the same copy of the system’s executable files located on the server platform via
the Local Area Network (LAN). Each workstation will need shortcuts to launch
programs installed on the server from the workstation’s desktop.
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Each workstation will need to have an ODBC Data Source Name (DSN) set up to allow
access to the shared repository database where it is located on the network or a single
FILE DSN located on the server that all users can share.

If your company has users in various physical locations that are not on the same LAN,
then:

e Each user workstation will need to install the Defect Manager product on their
machine

or

¢ Install the Defect Manager product on a separate server platform on each LAN.
Each workstation will need a desktop shortcut configured to launch the programs
on the server platform. Workstations must have their shortcuts to system
programs on the server linked to the proper server for their LAN.

To install Defect Manager, you run setup.exe from the directory where the Defect
Manager files are located.

If you have the CD-ROM for Defect Manager, the setup.exe program is located in the
root directory of the CD-ROM.

If you downloaded Defect Manager from the web, you will need to first: unzip the Defect
Manager file that you downloaded. After the Defect Manager file is unzipped, you can
run the setup.exe program from the expanded (i.e., unzipped) directory.

The Setup Wizard will walk you through the remaining parts of the install. Once you
have completed the install, you will be ready to configure the data source for the system
on each user’s workstation.

You will notice that running the setup.exe program has created shortcuts to the Defect
Manager Log and the Defect Manager Admin programs. You will need these shortcuts
to launch server-based programs that execute on the workstation.

When installing Defect Manager on a server in a shared folder, you can use Windows
Explorer to run the network setup.exe program for Defect Manager on each users
machine. The Defect Manager network install is located at: <your network install
location>\Network Install\ setup.exe. This will deploy Defect Manager for Windows
on this workstation creating the shortcuts that launch Defect Manager from the LAN
server.

Repeat this process on each Defect Manager user’s machine.
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Installing Defect Manager for Web

The “Thin Client” approach for web applications uses a browser on the workstation. The
workstation does not need an ODBC a Data Source Names (DSN) specified, since the
web-application on the web server communicates with the repository database. The web
server needs an ODBC FILE DSN defined to locate the repository.

Likewise, the browser program is typically installed on the hard drive in the workstation
S0 it may not need a shortcut for it on the workstation desktop.

Even if you are only using the web-based applications for Defect Manager, certain
workstations, such as your system administrator’s, will very likely need access to:

e “Client” programs such as the Defect Manager Admin and possibly others to
administer the system and perform a few functions that are not provided in the
web version.

e The repository database from “Client” programs executing on the workstation —
they require an ODBC Data Source Name (DSN or FILE DSN) to be defined on
the workstation.

You can configure specific workstations to work in “Client” mode by providing them
with appropriately configured shortcuts and an ODBC DSN.

Using Both Defect Manager for Windows and for Web

If you are going to use Defect Manager for Web and the Defect Manager for Windows
versions of the product, then you might consider installing the Defect Manager product
on your web-server platform to serve both “Thin Client” and “Client” needs.

With this approach, your users can run the web version and the Windows version from a
single-web-server installation of Defect Manager.

If you are using a third-party Internet Service Provider (ISP) or the installation of Defect
Manager for Windows is not feasible on your web-server platform, you can install
Defect Manager twice:

e |Install it on a network (LAN) server to support Defect Manager for Windows

e Install it on your Web Server to support Defect Manager for Web and E-Tech
Support.

Both of these installations should be configured to access the same repository database.

Using E-Tech Support

The installation process for the web-based application, E-Tech Support, is identical to the
process for Defect Manager for Web. Specific users gain permission to logon to this
system when the administrator creates and provides them user names and passwords.
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Establishing the Repository Database

A repository is a database of information about issue-defect items and your configuration
of options and coded values. By default, Defect Manager will use a Microsoft Access
database as its repository.

However, the system administrator can select other database systems as the database
engine for the repository. Defect manager also supports: Microsoft SQL Server, Oracle,
IBM DB2, Sybase, Ingres, and Postgres.

The Tiera Software Defect Manager is a very flexible system. You can use it to manage
one or many different repositories.

Using A Single Repository
Typically, the system will be installed and configured to use one shared repository so that
all issues and defects for all products are managed in one place — accessible by all users.

Defect Manager for Windows, is a “Client” application that executes on the workstation.
It will need an ODBC USER or SYSTEM ODBC Data Source Name (DSN) created on
each workstation in order to communicate with the shared repository database where-ever
it is located on the network. It is also possible to use a single shared FILE ODBC DSN
for all workstations when the Defect Manager Log program or the Defect Manager
Admin program is installed on a network server. See section: Using a FILE DSN.

Defect Manager for Web, is a web- based application that executes on the web server. It
will need an ODBC FILE Data Source Name (DSN) on the web-server to communicate
with the shared repository database where-ever it is located on the network.

The section, Configuring the Repository Data Source Name (DSN), describes how to
establish the proper DSNs for your organization.

Using Multiple Repositories
Multiple Defect Manager repositories might be desirable for organizations that want to
track and manage issues separately for:
e Different Product Lines or Projects
e Different Departments or Organizations within their Company
e Defined Date Intervals (e.g., retain prior years’ repositories and start a new
repository for the current year)

For example, a company’s products department may use one repository to track product
defects and enhancement requests while its IT department may use another repository
with Defect Manager to track company hardware and software trouble reports.
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Should your organization need multiple repositories, you can create them with Defect
Manager, but you must provide for them in the installation and administration of the
system.

Defect Manager for Windows, is a “Client” application. It will require an ODBC DSN
defined for each database that will be accessed from the workstation. Defect Manager is
expecting a specific DSN name (e.g., “defectmgrwe” for Access databases and
“defectmgr” for other types of databases) to locate the repository database. You may
use the following techniques to configure for your particular situation:

e Use an ODBC SYSTEM DSN, if each user and workstation will be using the
same repository with Defect Manager. This allows the same DSN name to link to
the same repository.

e Use an ODBC USER DSN, if each user logging onto a workstation needs to
reference a different repository database. This allows the same DSN name to link
to the appropriate repository for each user as he logs into the workstation and then
runs a Defect Manager client program.

e Use an ODBC FILE DSN (recommended), program command line parameters
can specify the ODBC DSN to selectively use multiple repositories. See the
section: Using a FILE DSN for additional information.

Defect Manager for Web is a web-based application. It is installed as a website on a
web-server that uses an ODBC FILE DSN to connect with the appropriate Repository
database.

When you use multiple repositories, you must create a separate Defect Manager website
instance (i.e., set of web pages) for each repository. In essence, you are establishing a
separate Defect Manager website application with its own repository — multiple times.

Each of these web-applications can be separately published to the web-server and have
their own initialization file, DefectManager.ini For web-installation information see
section: Installing Defect Manager for Web.
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Configuring Repository ODBC Connections

Open Data Base Connectivity (ODBC) is an industry standard established by Microsoft
that is the primary way multiple workstations and computer systems are able to
communicate by establishing connections with databases over a network.

An ODBC Data Source Name (DSN) is an object that stores the network-connection
information needed to send SQL commands and return database information.

ODBC DSN connections are configured using the ODBC Data Source (32 bit) tool found
on the Control Panel window of a Microsoft Windows ME/98/95 or NT 4.0 operating
system by navigating:

Start->Settings—> Control Panel>ODBC Data Source (32bit)
Alternatively, using Windows 2000/XP, you navigate by entering:

Start->Control Panel-> Administrative Tools->Data Sources (ODBC).
This will produce the ODBC DSN administration window shown below.

! DDBC Data Source Administrator 2|

Liser DSN |smemnsnl Fie DSM | Diivers | Trzcing | Connection Pooing | About |

Usger Data Sowrces:

Hame | Diver | A

IWS_QLSWH —!
Remove !
Configure... !

AnODBC User data source stores information about how to connect to
the indicated data provider, & Uger data source is only wisible to you,
and can only be used on the curent maching

QK i Cancel | Aol | Help |

Figure: ODBC Data Source (32bit) Configuration Form

There are three types of ODBC DSN connections that you can configure using the ODBC
Data Source (32-bit) tool using the first three tabs on the form shown above.

e USER ODBC DSN - This DSN is only available to the user that defined it on
this workstation when this user is logged on to this workstation.

e SYSTEM ODBC DSN - All users that log on to this workstation where this DSN
was defined will have access to it.

e FILE ODBC DSN - Globally, multiple users can share access to this DSN from
multiple workstations and computer systems, if they have the same database
driver.
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Using a FILE DSN

The Defect Manager Log application program and the Defect Manager Admin
program requires there to be an ODBC DSN named defectmgrwe for Microsoft Access
databases or defectmgr for the other types of databases used as the repository.

To deploy the Defect Manager for Windows system you need to
(1) Create a USER ODBC DSN on each user on each PC-workstation,
or
(2) Create a SYSTEM ODBC DSN on each PC-workstation,
or
(3) Create a single FILE DSN that can be shared by multiple users/workstations.

When you create a FILE DSN with the ODBC Administrator window, it generates a file
with the name of:

<data-source name>.dsn.

This file encapsulates all the information that is required to use the FILE DSN and
connect with the repository database.

In order for the Defect Manager Log program or the Defect Manager Admin program to
use the FILE DSN, you will need to specify this file name (i.e., a fully-qualified
pathname) as the first command line parameter when the program is launched or place
the FILE DSN in the installation \bin directory. You can embed command-line
parameters in a program-run statement within a shortcut to make it easy for users to
launch their Defect Manager programs.

If you have installed the product in a shared network directory, you can place the FILE
DSN in the \bin directory and all users can share the use of the FILE DSN.

Using command-line parameters can be useful, when you are using multiple repositories.
For instance, if you have two repositories, one that tracks defects for your product
division and one that tracks bugs for your IT group, you could set up two different
shortcuts. Each shortcut would be identical and use the same path to the executable name
(...\bin\log.exe), except that the first parameter after the executable name would be
different, and would specify the path of the appropriate FILE DSN that points to the
appropriate repository.

Remember, command-line parameters are specified as the first parameter after the
executable program name. If you are unfamiliar with specifying command line
parameters, you should review the appropriate windows documentation, or e-mail us at
support@tierasoft.com.
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To summarize, Defect Manager looks for its repository database as an ODBC data source
in the following sequence.

(1) Asa ODBC FILE DSN as the first parameter on the command line
(2) Asa ODBC FILE DSN in the \bin directory where Defect Manager is installed

(3) Asan ODBC USER OR SYSTEM DSN on the workstation called defectmgr
(for SQL Server, Oracle, IBM DB2, Ingres or Postgres databases) or
defectmgrwe (for the MS Access database)

The following sections describes how to configure a DSN on a workstation or server for
three of the types of databases that may be used to establish a Defect Manager
Repository: Microsoft Access, Oracle and SQL Server.

The other types database management system supported by Defect Manager (i.e., IBM
DB2, Sybase, Ingres, Postgres) are not illustrated since they are configured in similar way
using ODBC selections and drivers appropriate to each of these database systems.

Configuring the ODBC Data Source for Microsoft Access

If you are using the demo version of the product, you will not need to perform this
step; the ODBC data source is configured for you.

To use the Defect Manager for Windows system, you can set up a USER ODBC DSN
using the ODBC Administrator window from each user’s workstation.

To use the Defect Manager for Web system, you must set up a FILE OBDC DSN using
the ODBC Administrator window on the web server for Defect Manager.

The screen below: shows the ODBC DSN Administrator form with tabs for User, System
and File DSN definition.

£ 0DBC Data Source Administrator 2%

User DSN. | System D3N | Fle DM | Divers | Tracing | Connection Posling | Abaut |

User Data Sources:

Name | Diiver [ agd
SOL Server

Remove

flig

Configure...

£in DDBC User data source stores information about how to connect to
the indicated data provider. & User data source iz only wisible to you,
and can only be used on the curment machine,

0K I Lanicel | Aniy | Help |

Figure: Starting to Setup an ODBC Data Source

IG-13
© Copyright 1999-2008 Tiera Software, Inc. All rights reserved.



. . era
Defect Manager 4.6 Installation Guide sorTwaRe

You now need to push the Add Button. You will then be presented with the next screen
that allows you to create a new DSN:

Create Mew Daka Source ' ﬂ

Select a dmver fior which you want bo ¢et up a data source.

Mame i A
Dimver do Microzoft Excel[” xls) 4.
Dimver do Microzoft Paradox [*.db ) 4.
Dimver para o Microzoft Yisual FoxPro .
Microsoft Access Diver [F. mdb] 4.
Microsoft Access-Treber [*mdh) 4.
Microsoft dBaze Dmver [*.dbf] 4.
Microsoft dBaze VP Dimver [*.dbf] E.
Microsoft dBaze-Treher [ dbf) 4.
Microsoft Excel Dmver [* xls) 4. =
:.1' —— rm.LTmJ-.mlrx el ﬂJ

Canel |

Figure: Selecting the ODBC Data Source Driver

You need to tab down to Microsoft Access Driver (*.mdb) item in the list box and then
select the Finish button.

1G-14
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After getting this screen you will need to enter defectmgrwe (i.e., the DSN-name Defect
Manager expects when Ms Access is used) into the Data Source Name field.

ODBC Microsoft Access Setup 2| %
[lata Source MName; || (K
[ezcnphion: I

Cancel
- Databage
[ atabase: Help
Selet... | Creake. . ‘ Repar... Compact...
Advanced...
— Sustem Databaze
{* None
(" Database:
Sustem D atabaze. .
Dptiofzs »

Figure: Naming the ODBC Data Source

You then need to press the Select button and you will see the directory list dialog as
shown below:

IG-15
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You must find the Access database file called defects.mdb that is located in the directory
where you installed the Defect Manager system.

Select Database | X]
[ atabase MName Directones: ‘ qK |
|defects.mdb dh.

Cancel
| defectsmch YT A
[ Program Files w
[ Tiera Software Let

&5 DefectManager' = m oy
0 bin [ Exclusive
j (] schema i B

Lizt Files af Tups: Dirves:
Access Databases [ m j IEct j Hetwark... |

Figure: Linking to your Database as an ODBC Data Source

Once you have selected this file click the OK button. You will then return to the
Microsoft Access Data Sources Dialog as shown below:

IG-16
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The completed DSN definition is shown in the above window with the name,
defectmgrwe, that Defect Manager expects to find when a Microsoft Access database is

used.

DDBC Microsoft Access Setup 2] x|
Data Source Name: |defectmanwd [
[ezcnphion:

Cancel

—[atabaze

Databaze: 0. \defects mdb Help
Select. . Create. Repan... | Compact... |
Advanced...

— Snstem [ atabase

(% Norg
(" Database

Sustern Database..

Dptiongs »

Figure: Completing the Database Setup for an ODBC Data Source

Once again click the OK button.
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You will then be returned back to the ODBC Data Sources Dialog as shown below:

¢10DBC Data Source Administrator ipd
User [N | System DSN \ File: DSHI Driwas] Trat:'ngl Connection F'n:u:ulingl About |

IJzer Data Sources:

M are Cireer Aadd...
CRSS SOL Server R e
defectmgrwe  Microsoft Access Dirver [* mdb) Remaove

Configure...

An DDBEC User data sounce stores mformabion about how to connect b
the indizated data prowider. A Llser data source i only vizible to you,
and can only be used on the cument machine.

Cancel | Apply | Help

Figure: Final Step in Creating your ODBC Data Source

You can now click the OK button.

If you have installed the demo system, you can now use the Defect Log program to start
logging defects. Otherwise, you can proceed with the installation and administration
steps required to create or upgrade the repository and configure the system.
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Configuring the ODBC Data Source for Oracle

To use Oracle as the Defect Manager Repository database, you will need to establish an
ODBC Data Source Name (DSN) so that workstations and servers can communicate with
the Oracle-based repository over the network.

Before you can configure the DSN, you must create an initial Oracle user-id of
defectmgr and password of defectmgrpw. You will use this user-id when configuring
this data source.

ODBC DSN connections are configured using the ODBC Data Source (32 bit) tool found
on the Control Panel window of a Microsoft Windows ME/98/95 or NT 4.0 operating
system by navigating:

Start->Settings=>Control Panel>ODBC Data Source (32bit)
Alternatively, using Windows 2000/XP, you navigate by entering:

Start->Control Panel->Administrative Tools->Data Sources (ODBC).
This will produce the ODBC DSN administration window shown below.

¢10DBC Data Source Administrator 2| %

Usen DSN | System DSN | File D3N | Drivers | Tracing | Connection Foaling | About |

Izer Data Sowrces:

Mame | Dinver Add...
SOL Server T
Remave
Configure...

¢

fin DDBC User data source stores information about how bo connect ho
the indicated data provider. & [lzer data source iz only visible to pou,
and can only be used on the curent maching,

0k, Canel | AnnH ‘ Help

Figure: Starting to Setup an Oracle ODBC Data Source
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You now need to push the Add Button. You will then be presented with the next screen:

Create New Data Source ‘ X|

Select a dmver fior which you want to ¢et up a data source.

Mame &

Microsoft ODBC for Oracle
Microsoft Paradox Diver [F.db |
Microsoft Paradox-Treter [*.db |
Microsoft Text Dmver [ bt * cav)
Microsoft Text-Treber [* bt * cov
Microsoft Yisual FoxPro Dver
Microsoft Yisual FoxPro-Tretber

Dracle ODBC Dirver

Caniel |

Figure: Selecting the Oracle ODBC Data Source Driver

You need to tab down to Oracle Driver item in the list box and then select the Finish
button.

Note: Alternatively, you can use the Microsoft ODBC Oracle Driver
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You will then see the following screen:

Oracled ODBC Driver Setup

Clata Source Mame: ||

[Dezcrption: I

—[1ata Source

Service Mame;

1zl

[ atabaze Ophions
Connect to database in Read onbymode. [

Prefetch Court: |1

—Applizaton O phions
Eriable Thread Safety W

Enable Failayver W Retry Count |1l] Deday: |1III

— Tranzlaton Ophions
[Optian: 0

Librany:

[If.

Cancel

Help

Figure: Naming an Oracle ODBC Data Source

You need to enter defectmgr into the Data Source Name field. You will need to talk to

your database administrator about filling in the other fields.
Once again click the OK button.
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You will then be returned back to the ODBC Data Sources Dialog as shown below:

| DDBC Data Source Administrator 2%

User DSN | System DS | File DSN | Drivers | Tracing | Connection Pooing | About |

IJzer Data Sources:

Driver Aadd...
SOL Server
defectmgr  Oracle DDBC Divver Remaove
Configure...

An DDBC User data sounce stores mformabion about how to connect b
the indizated data prowider. A Lser data source iz only vizible to you,
and can only be used on the cument machine.

oK | Concel || gedb || Heb

Figure: Completing an Oracle ODBC Data Source

You can now click the OK button.
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Configuring the ODBC Data Source for SQL Server

To use Microsoft SQL Server as the Defect Manager Repository database, you will need
to establish an ODBC Data Source Name (DSN) so that workstations and servers can
communicate with the SQL Server-based repository over the network

Before you configure the data source you must create a Microsoft SQL Server user-id of
defectmgr. You will use this user-id when configuring this data source.

ODBC DSN connections are configured using the ODBC Data Source (32 bit) tool found
on the Control Panel window of a Microsoft Windows ME/98/95 or NT 4.0 operating
system by navigating:

Start->Settings=>Control Panel>ODBC Data Source (32bit)
Alternatively, using Windows 2000/XP, you navigate by entering:

Start->Control Panel->Administrative Tools->Data Sources (ODBC).
This will produce the ODBC DSN administration window shown below.

E:_!JZIJDBE Data Source Administrator 2]
Usen DSN | System DSH | FieDSM | Diivers | Tracing | Connestion Pooling | About |

Uszer Data Sources;

Name | Diiver | Add.
SDLSEWEI R

Remave

LCaonfigure...

€]

&n ODBC User data source stores information about how to connect to
the indicated data provider, & User data source iz only visible to vou,
and can only be uzed on the curent maching,

] 4 Caniel | Annl| | Help

Figure: Starting to Setup a Microsoft SQL Server ODBC Data Source
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Now push the Add Button. You will then be presented with the next window:
Create New Data Source ' ) ﬂ

Select a dmver fior which you want to ¢et up a data zource.

Mame &

Microsoft ODBC for Oracle
Microsoft Paradox Diver [F.db |
Microsoft Paradox-Treter [*.db |
Microsoft Text Dmver [ bt * cav)
Microsoft Text-Tredber [* bt * cov)
Microsoft Yisual FoxPro Dver
Microsoft Yisual FoxPro-Tretber
Oracle ODBC Dimver

SOL Server

Caniel |

Figure: Selecting the Microsoft SQL Server ODBC Data Source Driver

You need to tab down to the SQL Server item in the list box and then select the Finish
button.
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You will then get the following window:

Create a New Data Source ko SOL Server i ﬂ

Thiz wizard will help pou create an DDBC data source that vou can uze ta
connect bo SOL Server,

What name do vou want to use b refer to the data source™

Name: |

Haw do you want to describe the data source?

Description: |

Wihich SGL Server do you want to connect to?

Server I M

Firizh | = | Cancel Help |

Figure: Naming a Microsoft SQL Server ODBC Data Source

You need to enter defectmgr into the Name field. You will need to talk to your database
administrator about filling in the other fields required to complete this data source entry.

Once again click the OK button.
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You will then be returned back to the ODBC Data Sources Dialog as show below:

| 0DBC Data Source Administrator E:_5::'5..'5,; 2x|

User DSN | System DS | File DSN | Drivers | Tracing | Connection Pooing | About

Izer Data Sources:

Driver Add...
SOL Server
defectmgr  SOL Server Remove
Configure...

An DDBEC User data source stores mformabion about how to connect b
the indizated data prowider. A Lser data source i only vizible to you,
and can only be wsed on the cument machine.

oK | cocel || Besb | Heb

Figure: Completing the Setup of a Microsoft SQL Server ODBC Data Source

You can now click the OK button.
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Deploying the Defect Manager for Windows System

After you have designed, configured and tested the system, you will want to deliver the
system to all the users in your company that will use the system. There are several
options available for deploying the Defect Manager systems:

e Defect Manager for Windows — Client/Server implementation for LAN users
e Defect Manager for Web — Web implementation for Internet/Extranet users
e E-Tech Support — Web implementation for Internet clients you support

One thing you need to keep in mind is that Defect Manager for Windows is a
client/server application. This means that your users will run their “Client” applications
on their workstations with the application software loaded into either:

e A hard drive that is attached to their PC-workstation
or
e Ashared directory on a hard drive located on a LAN server.

The Defect Manager Repository is typically located on a separate PC-server platform on
the LAN.

The Defect Manager for Web and E-Tech Support systems are based on a web server so
these applications are not deployed on the PC workstations since they use a browser
program such as Microsoft Internet Explorer (IE) or Netscape Navigator. The web-
based application installation considerations are covered later in section: Installing Defect
Manager for Web and Installing E-Tech Support.

The next few sections are dedicated to looking at the choices you have for deploying the
client and the database portions of the Defect Manager system.

Deploying the Client Application

There are basically two things you need to consider when deploying the client
application. The first is the location of the application and the second is the configuring
of the ODBC data source. Lets examine these two things in closer detail.

Client Application Location

There are only two choices of where to put the Defect Manager for Windows client
application.

1. Each user installs the product on their workstation’s hard drive from a network
drive or from the product CD or web download.

2. Install the product in a shared network-drive accessible to all the users.
(Obviously the user would need to be part of the domain or workgroup, but that
is a very common situation).

To make your life easier, we strongly recommend you choose the second (#2) of the two
approaches for several reasons.
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e When you need to apply fixes or upgrades to the software you only do it
in one place. (i.e. to the one shared network drive). Otherwise, you will
have to manage the installation of updates on all user workstations.

e You avoid the possibility of someone incorrectly installing the product
and the associated troubleshooting and support of multiple workstations.
If you have lots of users and workstations, this could take a long time.

We also recommend that you configure the shortcuts to the product appear on the desktop
when they connect to the domain, so you don’t have to set up the shortcuts on each
machine.

When installing on a network drive, you can “share” the directory with the others that
will be using the system. Defect Manager does support the Universal Naming
Convention (UNC) for data files to make it easier for other users access the Defect
Manager product.

After you have installed the product to a server on the LAN, you can run the Defect
Manager network install on each users machine to allow the user to access Defect
Manager for Windows. This needs to be done for the following reasons:

e Sets up the proper shortcuts for Defect Manager on the user’s workstation
e Installs the reporting components on the user’s workstation
If you do not do this, reporting will not work for each user.

The network install is located in the /Network Install directory under the root directory

where you installed the product. Just run the setup.exe program from the /Network
Install on each users machine.
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When you run this setup.exe prompt, you will only be given one prompt, as show below.

Choose Destination Location il

Fleaze enter the directany on the netwark, where the product iz
cLrently installed.

Browsze. .. |

< Back Mest = Cancel

Figure: Defect Manager for Windows Setup Prompt Window

This is where you specify the location of the Defect Manager installation on the network
server. This can be specified as a pathname or a UNC name. For example, you might
enter the following:

Z:\\Program Files\Tiera Software\Defect Manager Release 46
or
\\servermachine\DefectManager
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Passwords

Defect Manager has its own user name and password system. When you logon to Defect
Manager, you will be prompted for a user name and password. The logon identifies the
current user; this allows Defect Manager to enforce permissions and restrictions on a
user’s operations.

Defect Manager uses an underlying database as its repository. When it is an industrial-
strength database such as Oracle, SQL Server, IBM DB2, Sybase, Ingres and
Postgres,they require user names and passwords to access certain resources. When any of
these databases are used with Defect Manager, you will need to consider the following.

When you configure Defect Manager, there are several options on how the user will enter
passwords. Regardless of which option you choose, the user must always enter the user
name and password in the Defect Manager Login screen that has been defined for the
user in the Defect Manager repository.

The Defect Manager system administrator is allowed to view these user name and
passwords.

When starting the Defect Manger Log and Defect Manager Admin programs, password
security will always be enforced by the Defect Manager Logon screen.

After entering user name and password, Defect Manager will then need to establish a
connection to the database so the user name and password that was entered can be
verified by data stored in the Defect Manager repository.

This raises the question of “What user name and password should Defect Manager use to
connect to the repository database?”” There are three choices:

1. Defect Manager will prompt the user for the database user name and password.

2. The second choice is that Defect Manager will pass the user name and password
that was entered on the Defect Manager Logon window and use it to gain access
to the repository database.

3. Defect Manager will always use the same user name and password to establish a
connection to the underlying database.

Why so many choices? The answer to this question is that each organization has different
rules on how user names and passwords are set up for individuals and its databases.
Defect Manager provides support for these different security schemes.
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Option Type

Benefits

Tradeoffs

1. Prompts the user for
database user and password.

LogonOption=P

The user will always be
authenticated by the
database every time they
use Defect Manager.

The user is only accessing
database resources for
them.

User has to remember and
enter the Defect Manager
user name and password,
and the Database user name
and password every time.

There must be a unique
database account for every
user of Defect Manager.

2. Uses the user name and
password from the Defect
Manager Logon window.

LogonOption=U

The user will always be
authenticated by the
database every time they
use Defect Manager.

The user is only accessing
database resources for
them.

The user only has to
remember the Defect
Manager user name and
password.

There must be a unique
database account for every
user of Defect Manager.

The database user name and
password must always
match the Defect Manager
user name and password.

3. Always use the same
user name and password for
each user.

LogonOption=D

Never need to add new
database users when adding
new Defect Manager users.

The user only has to
remember the Defect
Manager user name and
password.

All users will be
authenticated by the
database as the same user.

All users are accessing the
same database resources. If
someone does something
inappropriate, you cannot
track down who did it.

After you have decided which option is the best for you, proceed to the next section

where we will tell you how to set the option that you select.

Note: These options are not valid when using a FILE DSN. When using a FILE DSN, you
specify the userid and password by setting the UID=username and PWD=password
parameters in the FILE DSN file directly. For additional information, see section:

Using a FILE DSN.
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Defect Manager Initialization File

In general, the Repository contains both the data and configuration data, However, there
is one exception currently.

The options on how we connect to the database must be kept on a local disk drive in a
windows initialization file. The name of the file is DefectManager.ini. The Defect
Manager initialization file is read when you start Defect Manager. Defect Manager first
looks for this file in the:

1. Windows System directory on the local platform

2. Then in the \bin directory where the product has been installed. When the product
is installed a DefectManager.ini file is placed there by default..

For example, a DefectManager.ini file looks something like this:

[Config]
LogonOption=P
UID=username
PWD=password

The initialization file parameters are explained below:

e The LogonOption specifies how you want the database user name and password set.
This option has three possible values, as follows:

P — Prompt for database username and password
U — Use the Defect Manager entered user name and password
D — Use the UID and PWD parameters as the Default values

e The UID=and PWD= parameters are only used when selecting option D. When you
use option D set the UID=username and the PWD=password. This is the single
database username and password that will be shared by all Defect Manager users
connecting to this repository database. See section Passwords for more info on these
choices.
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Upgrading The System

If you are installing Defect Manager for the first time, you do not need to upgrade the
system.

If you are a current Defect Manager user, you will need to upgrade your current system.
Before upgrading, we recommend the following test procedure:

(1) Install Defect Manager Release 4.6 as described in the Installation Guide.

(2) Copy your production repository database to make a new database. You will use this
database to test Defect Manager 4.6 with your production data before going live.

(3) Copy the file DefectManager.ini from the \bin directory in the existing Defect
Manager installation to the \bin directory of the Release 4.6 installation.

(4) Copy all files (and all sub directories) under the existing \Attachments directory into
the \Attachments directory in the Release 4.6 installation directory.

(5) Create a new defectmgr FILEDSN that points to the new copy (created in step #2) of
your production database. Put the new defectmgr.dsn in the Release 4.6 \bin
directory.

(6) Open a Command Window (cmd.exe). On the command line change the current
directory (using the CHDIR DOS command) to the \bin directory in the Release 4.6
installation and run the upgrade.exe program. You can also use Windows Explorer to
run upgrade.exe by double clicking on it.

(7) Test Defect Manager 4.6 using the new copy of your production repository data by
experimenting with some operations and reports. Try some of the new features. Make
sure your data looks correct.

After you feel comfortable with Release 4.6 and want to go live, you should perform
the following steps.

(1) Backup your existing database.

(2) Copy the DefectManager.ini from the \bin directory in the existing Defect Manager
installation to the \bin directory of the Release 4.6 installation.

(3) Copy all files (and all sub-directories) under the \Attachments directory in the
existing Defect Manager installation to the \Attachments directory in the Release 4.6
installation.

(4) Copy the defectmgr.dsn (or defectmgrwe.dsn, if using Access) under the \bin
directory in the existing Defect Manager installation to the Release 4.6 \bin directory.

(5) Open a Command Window (cmd.exe). Change the current directory to the \bin
directory of the Release 4.6 installation (using the CHDIR DOS command) and run
the upgrade.exe program.

When you are running the upgrade.exe program, you will see a lot of output displayed
on your monitor which will be very difficult to read as it scrolls by quickly. That’s OK.
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All of the output that is displayed is also written to a log file in the \upgrade sub-
directory. You will only be interested in viewing the last line that is displayed on the
screen. The last line will tell you whether the system has been upgraded successfully or
not. If the system has been upgraded, Defect Manager is ready for use.

If the last line tells you that it could not upgrade the system, you can e-mail and attach the
output from the upgrade.exe program run that was recorded in the log file to Tiera
Software Technical Support. The upgrade log file to attach is located in the Release 4.6
\upgrade directory.

When you upgrade the system by running upgrade.exe from the \bin directory, the
upgrade.exe program makes the following assumptions:

e The home directory for Defect Manager is one directory above upgrade.exe.

e |IfaFILEDSN is found in the same directory as upgrade.exe (which will probably
be the case), it will upgrade the associated database. If the FILEDSN does not
exist, it terminates without upgrading a repository database.

If you are not using a FILEDSN, and you are using a user/system ODBC DSN (Data
Source Name) as a source, you can use the DBUSER and DBPASSWORD command line
parameters to specify the username and password associated with the user/system data
source.

You can also specify the location for the FILEDSN and HOME directory via command
line parameters.

Defect Manager is a standalone executable program that accepts the following
parameters:

upgrade HOME="dmhomepath” FILEDSN="dmfiledsnpath”
DBUSER="dbusername” DBPASSWORD="dbpassword”

Please observe the following notes:
e All parameters are separated by blanks.

e All parameter values such as dmhomepath, that contain embedded blanks must
have quotes around them.

e There should be no spaces between a parameter name and a parameter value.
Explanation of parameters follows.
e [HOME="dmhomepath”]

This parameter is the path where the Defect Manager product is installed. If the
product was installed in c:\\Program Files\Defect Manager, then this parameter
would be:

HOME="c:\Program Files\Defect Manager”
e [FILEDSN="dmfiledsnpath’]
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This optional parameter is the path where the FILEDSN is located. The FILEDSN is
used to connect to the database via an ODBC Data Source Name (DSN).

(o] The Defect Manager Reminder program will automatically look for the
defectmgrwe.dsn (the default, for Microsoft Access repository).

If you are using Access to implement your repository, this DSN is the default so
you can omit this parameter.

o] If you are using another type of database to implement your repository, use
the FILEDSN value defectmgr.dsn (for SQLServer, Oracle, IBM DB2, Sybase,
Ingres, and Postgres) in the \bin directory where you installed the product.

o] If you are using a FILEDSN in another location, such as
c:\Document Settings\Common\ODBC\defectmgr.dsn,
then this parameter would be:
FILEDSN=" c:\Document Settings\Common\ODBC\defectmgr.dsn”
e [DBUSER="dbusername”]

This optional parameter is used if you configured the system with an ODBC DSN (data
source name) of defectmgr .

A Microsoft Access database does not require this parameter, but the other types of
databases used to implement the repository require it. If the specified user name requires
a password, then you will also need to specify the DBPASSWORD parameter as well.

e [DBPASSWORD="dbpassword”]

This optional parameter is used only if you configured the system with an ODBC data
source of defectmgr (for SQLServer, Oracle, IBM DB2, Sybase, Ingres, and Postgres)
and the DBUSER name requires a password.
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Deploying Defect Manager for Web

Defect Manager Release 4 introduced two new web components that you can install and
use to deploy on a web server.

e Defect Manager for Web — A way for local and remote users to access the Defect
Manager features, repository and knowledgebase over the internet or extranet.

e E-Tech Support — A way for remote clients and third-parties to access the Defect
Manager repository and knowledgebase on a limited basis over he internet.

Defect Manager for Web is essentially the same as the Defect Manager for Windows,
except that it runs from a web browser.

The web interfaces require 11S 5.0 or greater. The web interfaces are written using
Active Server Pages (ASP.net) and include a single COM+ component. When you install
the product on the web server, the COM+ component (plogcomponent46.dll) is installed
and registered automatically.

To configure the Defect Manager Web interface, you will need to perform the following
steps:

1. Make the Defect Manager web pages available from the web server (11S) — Using
the IIS Administrator, create a virtual directory named dm465prod that points to
the web\defectmgr.net sub-directory where you installed the product. This is
usually, c:\Program Files\Tiera Software\Defect Manager Release
460\web\defectmgr.net. Make sure that the virtual directory is enabled for ASP.net
2.0.

2. Enable the ASP.NET (if on domain this is usually the local network service) on
to have full control of the Defect Manager installation which is usually
c:\Program Files\Tiera Software\Defect Manager Release 460.

3. Ifyou are installing on a Windows Server 2003 or Windows XP Pro, you will need to
follow this additional steps. Right click on the virtual directory in step 1. and select
Properties. Next, press the Configuration button in the right corner. When the
Application Configuration window appears, select the Options folder. Check the
Enable parent paths checkbox and make sure the Default ASP Language is
VBScript. Then click the OK button to close the current property page, and then
select the OK button again to close the main property page. Secondly, if you are
installing on Windows 2003 Server, you must also allow 1S to process ASP .net
pages. To do so, click on the Web Services Extensions in the I1S application tree.
In the right pane, click on ASP .net 2.0 and press the Allow button.

4. If you did not take the defaults at installation time, you will need to change the
web.config file located in the web\defectmgr.net sub-directory. Two statements
need to be changed.

The is to modify line 3 from:

<add key=""DefectManagerFILEDSN" value = ""c:\Program
Files\Tiera Software\Defect Manager Release 460"
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to

<add key=""DefectManagerFILEDSN" value = ""fullpathname where
you installed the product *'/>

The second change is to modify line 4.
If you are using Access as the database repository, then change line 4 from:

<add key=""DefectManagerHome" value="FILEDSN=c:\Program
Files\Tiera Software\Defect Manager Release
460\bin\defectmgrwe.dsn"'/>

to

<add key=""DefectManagerHome"" value=""FILEDSN=""fullpathname
where you installed the product\bin \defectmgrwe.dsn"'/>

If you are using SQLServer Or Oracle as the database repository, then change line
4 from:

<add key=""DefectManagerHome"" value="FILEDSN=c:\Program
Files\Tiera Software\Defect Manager Release
460\bin\defectmgrwe.dsn"'/>

to

<add key=""DefectManagerHome"" value=""FILEDSN=""fullpathname
where you installed the product\bin \defectmgr.dsn*'/>

You can test this by opening a browser and using the following URL.:
http://hostname/dm465prod/

where
Hostname is the name of the machine where you installed Defect Manager.

Deploying E-Tech Support
To install and configure the E-Tech Support subsystem, you will need to perform the
following steps to deploy the system on a web server:

To configure the Defect Manager Web interface, you will need to perform the following
steps:

1. Make the Defect Manager web pages available from the web server (11S) — Using
the IIS Administrator, create a virtual directory named etechsupport that points
to the web\etechsupport.net sub-directory where you installed the product. This
is usually, c:\Program Files\Tiera Software\Defect Manager Release
460\web\defectmgr.net. Make sure that the virtual directory is enabled for ASP.net
2.0.
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2. Enable the ASP.NET user to have full control of the Defect Manager installation
which is usually c:\Program Files\Tiera Software\Defect Manager Release 460.

3. If you are installing on a Windows Server 2003 or Windows XP Pro, you will need to
follow this additional steps. Right click on the virtual directory in step 1. and select
Properties. Next, press the Configuration button in the right corner. When the
Application Configuration window appears, select the Options folder. Check the
Enable parent paths checkbox and make sure the Default ASP Language is
VBScript. Then click the OK button to close the current property page, and then
select the OK button again to close the main property page. Secondly, if you are
installing on Windows 2003 Server, you must also allow 1S to process ASP .net
pages. To do so, click on the Web Services Extensions in the I1S application tree.
In the right pane, click on ASP .net 2.0 and press the Allow button.

4. If you did not take the defaults at installation time, you will need to change the
web.config file located in the web\etechsupport.net sub-directory. Two
statements need to be changed.

The is to modify line 3 from:

<add key=""DefectManagerFILEDSN" value = "*c:\Program
Files\Tiera Software\Defect Manager Release 460"

to

<add key=""DefectManagerFILEDSN"" value = ""ful Ipath name where
you installed the product *'/>

The second change is to modify line 4.
If you are not using Access as the database repository, then change line 4 from:

<add key=""DefectManagerHome" value="FILEDSN=c:\Program
Files\Tiera Software\Defect Manager Release
460\bin\defectmgrwe.dsn"/>

to

<add key=""DefectManagerHome"" value=""FILEDSN=""fullpathname
where you installed the product\bin \defectmgrwe.dsn"'/>

If you are using SQLServer Or Oracle as the database repository, then change line
4 from:

<add key=""DefectManagerHome"" value="FILEDSN=c:\Program
Files\Tiera Software\Defect Manager Release
460\bin\defectmgrwe.dsn"'/>

to

<add key=""DefectManagerHome"" value=""FILEDSN=""fullpathname
where you installed the product\bin \defectmgr.dsn*'/>
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You can test this by opening a browser and using the following URL.:
http://hostname/etechsupport/

where
hostname is the name of the machine where you installed Defect Manager.

POP Server Support

Many e-mails are sent to your company from a variety of sources asking for information,
or reporting certain issues. The Defect Manger POP Server allows Defect Manager to
read e-mail (and their attachments) from any POP3 e-mail boxes and enter those issues
into the Defect Manager repository. This allows your company to organize, monitor,
manage and resolve e-mail questions and issues from a central location using a single
tool.

Setting up the POP Server is a two step process. The first step is to configure the e-mail
boxes to be processed. The second step is to install the POP server system service.

To configure POP Server support you need to use the Defect Manager Windows
interface. Please review the Defect manager Administration Guide — Windows for more
information.

Configuring POP Servers

POP Server’s can be configured using the Defect Manager Administrator for Windows
interface.

To configure POP Server support, select the File->Repository Settings menu item and
then select the POP Server Tab. It is shown below in the following figure.
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System Settings x
General ] User Defined Fields ] User Defined Fields {l:orrt}] E-mail Settings ] E-Tech Support  POF Server
— POP Servers 1
II""|E""‘:Eﬁ"%5| Mai":"ﬂu ’ Server Name: 1F‘mu:|uu:1'| Support Mailbex1
Product2 Support Mailbo1 Mailbox Host Name: |product 1@tierasoft.com
Sales Mailbox : .
\Web Master Mailbax Mailbox User MName: 1|:|n:u:|uct1|
Mailbox Password: ]'"
Set Status to: jﬁccepted ~f_j
Assign it to: iBmd [System Admin) j
Set Severtty to: [ <not set> =
Give it a Prionty of : i-{nnt sets j
Put it in Wark Queue: i:nnt st __ﬂ
Product: ]F‘n:ujeu:t 1 :J
Product Release: JHeIease 121 j
Platform: 1‘."'.|'inu:h:|ws _.'.i
Platform Release: IEI}I}D ___'_J
Default Client: 1'_.r|:|ur Comparny name Lj
Default Location: iDefauh Li
Mewe 1 Save ] Remove 1

[ ok | cancel ‘ ‘ Help |

Figure: Configuring POP Servers

To add a POP Server, follow these instructions.
= Click the New button.
= Enter the following fields.
o Server Name — The descriptive name for this POP Server e-mail box.

o Mailbox Host Name — The hostname where the e-mail box exists. This is
usually a domain name such as mail.domain.com for example.

Mailbox User Name — The user name for the e-mail box.
Mailbox Password — The password for the user name for the e-mail box.

= Select the remaining default issue fields such Status, Assignee, etc.
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= Click the Save button.
To modify a POP Server, follow these steps.

= Select the POP Server from the POP Servers List.

= Change the Settings.

= Click the Save button.
To remove a POP Server, follow these steps.

= Select the POP Server from the POP Servers List.

= Click the Remove button.

Installing and Starting the POP Server Service

The POP Server process is a system service that reads E-mail inboxes and places them in
the Defect Manager repository. To install the service, click on the
POP3ServerServicelnstall.bat file located in the Defect Manager \bin sub-folder. After
running this batch file, the service be installed. Before the service can start reading e-mail
boxes, it needs to be running. To start the service, follow these steps.

= Navigate to the Services application by selecting Start-> Control

Panel->Administrative Tools—=>Services.
= Locate the service named DM POP3 Manager in the list of services.
= Right click on this entry and select the Start menu item.

The service will start and stay active until you reboot the system. When the system
restarts you will manually need to start the service again. If you want to have the service
start automatically every time the system restarts (this is the preferred way), then follow
these steps.

= Navigate to the Services application by selecting Start-> Control
Panel=>Administrative Tools—=>Services.

= Locate the service named DM POP3 Manager in the list of services.

= Right click on this entry and select the Properties menu item.

= Select the Startup Type field to automatic as show below
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DM POP3 Manager Properties (Local Computer)

General | Log On | Recovery | Dependencies

Service name: OmM POP3SERVER

Display name: DM POF3 Manager

Diescription: Reads All Defect Manager E-Mail Messages

Path to executable:
C:%Program Files'Tiera Software*Defect Manager Release 4200bin"\POP3

Startup type: Manual v

Service status:  Stopped

You can specify the start parameters that apply when you start the service
from here.

Start parameters:

| ok || cancel || epy |

Figure: Automatically starting the POP Service

Troubleshooting POP Server Errors

If the POP server unexpectedly terminates, there are two places to look to help figure out
why. The first place is the System Event Viewer and the POP Server Log. The
POP3Server.exe places the log file in the \POP3Server\Log directory.

The log filename format is:
logmm-dd-yyyy-hh-mm-ss.txt
where mm is month,
dd is day,
Yyyy is year,
hh is hour,
mm is minute and
ss is the second that the reminder was run.

You can view this file with any text file viewer, including notepad. You should
periodically delete obsolete log files to reclaim disk space.
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E-mail Manager

Defect Manager sends e-mail alerts and e-mail form letters based on certain situations
that arise during the normal operation of the system. To maximize user response time and
resource usage, Defect Manager caches the e-mail alerts and e-mail form letters in the
repository. It is up to the E-mail Manager to read the e-mail cache and send the e-mails
to their intended recipients.

The next two sections describe how to start/stop and troubleshoot any issues with the E-
mail Manager.

Installing and Starting the E-mail Manager

To send system generated e-mails, the E-Mail Manager service must be started. To
install the service, click on the MailManagerServicelnstall.bat file located in the Defect
Manager \bin sub-folder. After running this batch file, the service is now installed.
Before the service can start reading e-mail boxes, it needs to be running. To start the
service, follow these steps.

= Navigate to the Services application by selecting Start-> Control

Panel=>Administrative Tools—=>Services.
= Locate the service named DM Mail Manager in the list of services.
= Right click on this entry and select the Start menu item.

The service will start and stay active until you reboot the system. When the system
restarts you will manually need to start the service again. If you want to have the service
start automatically every time the system restarts (this is the preferred way), then follow
these steps.

= Navigate to the Services application by selecting Start-> Control
Panel=>Administrative Tools—=>Services.

= Locate the service named DM Mail Manager in the list of services.

= Right click on this entry and select the Properties menu item.

= Select the Startup Type field to automatic as show below
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DM Mail Manager Properties (Local Computer)

General | Log On | Recovery | Dependencies

Service name: DM MailManager

Display name: DM Mail Manager

Description: Sends All Defect Manager E-Mail Messages
Path to executable:

:Program Files*Tiera Software*Defect Manager Release 4200bin%MailMa

Startup type: Automatic v

Service status:  Stopped

You can specify the start parameters that apphy when you start the service
from here.

Start parameters:

| ok || cancel || Aoy

]

Figure: Automaticadlly starting the E-mail Manager Service

Web Security

There are many things you need to consider when you deploy any web application.
If you are not familiar these issues, you should consult an Internet security expert.

Defect Manager supports several levels of security:

1G-44

User security — Using the Defect Manager Administrator you set passwords and
privileges for users

WIin/NT Security — If you set up IS to use Basic or Challenge/Response security,
Defect Manager will use the username and password that is authorized by the
Win/NT operating system as the username and password to log on to Defect
Manager. This is true for both Defect Manager for Web as well as E-Tech
Support. When the user tries to access Defect Manager, they will be given a
dialog box to enter their credentials.

When using Win/NT security, you need to define each Defect Manager user to the
operating system.

© Copyright 1999-2008 Tiera Software, Inc. All rights reserved.



i RN
. . era
Defect Manager 4.6 Installation Guide sorTwaRe

If the operating system authenticates the user, Defect Manager and the
workstation must use the same username and password. This means that you will
need to add the same username and password to the Defect Manager repository
whenever you add a new username and password to the operating system.

Installation Checklist

Defect Manager has been designed for easy installation requiring a minimum of time and
effort. Typically a single system administrator can install Defect Manager for an
organization in a matter of a few hours or less depending the complexity of your user
network and the degree of customization you wish to make to Defect Manager.

Installation Checklist Overview

Below, you will find a checklist of tasks that need to be performed to successfully install
Defect Manager. You can also review the on-line help file for more information after
Step 3 in the installation checklist has been completed. You can view the help file by
selecting the Defect Manager Help shortcut that is created by the installation setup
program.

If you have problems, you can use any of the following support mechanisms:

e The welcome letter that you received will provide you with all the information
you need to get started.

e (o to http://www.tierasoft.com/support_login.asp to access the support
knowledgebase and, optionally, report a problem.

e E-mail technical support support@tierasoft.com

e Contact the technical support person that to assigned to you via phone, e-mail, etc.

e Call our toll free support number

Follow the installation checklist steps shown below.
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Step 1: Create the Defect Manager Repository Database

Step

Done By

Instructions

1. Create the Defect
Manager Repository
Database.

DBA

Access database: Use the defects.mdb
repository database that ships with the product or
use the ODBC Manager and Microsoft Access to
create an empty Access database (.mdb).

If you are going to use the supplied defects.mdb
that ships with the product, then you only need to
perform Steps 3, and 5.

DBA

All other databases: Consult the appropriate
database documentation to create a database for
the Defect Manager repository.

We do not require any special database attribute
settings or database features. Just create a
database that has ample space.

It is hard to estimate how large to make the
database because each company’s capacity needs
are different as well as the amount of
information associated and attached to each
defect-issue item.

As a general estimating factor, you can assume
the Defect Manager Repository database
requires:

100MB / 5,000 stored defect-issue items.
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Step 2: Create Repository Database Usernames & Passwords

Step Done By Instructions
2. Create the DBA Access database: N/A for Microsoft Access
database user(s) that databases

connect to the Defect
Manager Repository
database(s)

DBA All others: This is the Defect Manager user(s)
that will connect to the repository database.

Defect Manager has its own internal security,
where you can establish specific user privileges
for each user.

You do not need to add a database user for each
Defect Manager user of the system. Defect
Manager can connect to its repository database
using a single database username and password
pair for all users.

The database user you create must be

GRANT ed the following privileges using SQL:
e CREATE - Only used to create the

repository. Can be revoked after the

repository has been created.

SELECT

INSERT

UPDATE

DELECT - Only required when users are

allowed to delete defects.

When using multiple repositories, repeat this
step for each repository database.
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Step 3: Install Defect Manager Software

Step Done By Instructions

3. Install Defect Win/NT System | User’s Workstation Install: The Defect
Manager Software | Administrator Manager product software must be installed on
Product the hard drive for each workstation.

Win/NT System | LAN Server Install: The recommended
Administrator approach. Install the Defect Manager product
software on a selected server in your LAN
network in a shared drive and directory folder.

You must do the network workstation install
operation from each user’s workstation to
configure the desktop shortcuts and reports for
each user.

The network install setup program will be in
the Network Install sub-directory where you
installed the Defect Manager product. You
must make sure that the /bin sub-directory
where Defect Manager is installed is
configured as shared.

Win/NT System | CD-ROM Install: If you are installing the
Administrator product from its release CD-ROM, place the
CD in the CD drive on the server machine. If
the CD does not automatically begin installing,
run the setup.exe program from the CD-drive
root directory.

Win/NT System | Web Download Install: If you are installing
Administrator | the product from a web-download, unzip the
downloaded file into a temporary directory

Note: As a part of the install process, you will
select the network directory folder (root
directory) where Defect Manager is installed.

Best Practice: The recommended approach is to install Defect Manager on a LAN Server
with a shared /bin folder. This will minimize system maintenance since the workstations
are all sharing one install-point on the server. You can follow UNC file naming
conventions when setting up Defect Manager.

Any workstations that cannot access the server machine will need additional installs of the
product to the local hard drive on their workstation or a to a server that is on its local
LAN.
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Step 4: Create Default ODBC DSN Connection

Step Done By Instructions
4. Create default Win/NT Access Database: Use the ODBC
ODBC DSN for System Administrator to create a FILE DSN named

Defect Manager to
use to connect with
its repository
database.

Administrator

defectmgrwe.dsn for the demonstration or
Access database you created in step 2.

After the FILE DSN is created, copy it into the
\bin sub-directory.

Other databases: Use the ODBC
Administrator to create a FILE DSN named
defectmgr.dsn for the database user(s) you
created in step 2. More than one FILE DSN is
needed, if multiple repositories are used.

After the FILE DSN has been created, edit the
defectmgr.dsn file and specify two additional
parameters on separate lines of the file:

1. UlD=<database username>

2. PWD=<database password>
Save the defectmgr.dsn file and copy it to the
\bin directory.
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Step 5: Create the Defect Manager Repository

Step

Done By

Instructions

5. Create the Defect
Manager Repository
and Check System
Settings

Win/NT System
Administrator

1.

IS

On the Server Platform:

Copy the license you were e-mailed
from Tiera Software into the \bin sub-
directory.

The license file contains the
information about your database type.
If you do not copy the license file
Defect Manager will assume you are
using the default database — Microsoft
Access.

Run the Defect Manager Admin
program using: Start->Tiera
Software->Defect Manager Admin
If prompted by the ODBC connect
dialog to enter a user name and
password, enter the user name and
password for the Database-User that
you are connecting as.

When prompted with the Defect
Manager Logon window, specify the
user name: Admin and password:
Admin.

Select: File>Run Script

Browse to the \scripts sub-directory
where you installed the Defect Manager
product.

Review and, optionally, edit the
Repository Settings.

Exit the Defect Manager Admin
program
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Step 6: Configure the System

Step

Done By

Instructions

6. Configure the
Defect Manager
System

Defect Manager
Administrator

First, Configure the system settings:

1.

Run Defect Manager Admin program:
Start->Tiera Software—>Defect Manager
Admin

Enter Admin as the username and Admin
as the password to logon.

Second, Load Default Objects and Codes
using Scripts:

1.
2.

3.

Select: File=>Run Script

Browse to the \scripts sub-directory where
the Defect Manager product is installed
Select the script, such as
LoadDefaultStatuses.sql to load the
default status codes.

Change the password associated with the
Admin user name to a secure password.

Third, Customize System Objects:

Use the Defect Manager Admin program to
tailor system objects and codes to meet the
needs of your organization.
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Step 7: Install Defect Manager on each Workstation

Step

Done By

Instructions

7. Install Defect
Manager product
on each users
workstation

Systems
Administrator

If you are going to install the complete Defect
Manager product on the hard-drive of one or
more user’s workstations:

1. Install the product on the workstation
hard disk from the product CD-ROM or
Copy a download of the system to the
workstation.

2. Run the setup.exe program on the
workstation from the CD-drive or the
hard-drive on the workstation.

3. Copy the defectmgr.dsn file into the
Defect Manager \bin sub-directory on
this workstation.

4. Repeat steps 1-3 for each workstation
requiring this type of install.

Note: A network installation is the
recommended approach when multiple users
are present on a LAN.

If you installed the product on a LAN
Server, use the network install in the
\Network Install directory.

1. Run ...\Network Install\setup.exe to
perform the network install on each
workstation to share a common
installed copy of the programs over the
LAN.

2. When prompted by the setup.exe
installer program, specify the Defect
Manager root directory on the server
machine using the format:
<network drive>:/<root-pathname>
or UNC pathname:

/[<machine>/<sharename>

Note: If you do not specify the correct
root directory, some features such as
reporting may not work properly.
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Step 8: Setup Defect Manager for Web Components

Step Done By Instructions

8. Setup Defect System Defect Manger for Web, if you will be using it --
Manager for Web | Administrator | you will need to do the following:

Components or 1. Using IIS, create a virtual directory (any name

Web Master

that you want) that points to the
\web\defectmgr.net sub-directory. You will
need to allow read access and scripting. The
default scripting language should be VBScript
not JScript. Make sure you check the Enable
Parent Paths option. This is the virtual
directory that you will use to run Defect
Manager for Web.

Enable the directory to have ASP.Net 2.0
support.

Allow the user ASP.Net to have full control of
the Defect manager Installation. The default
installation directory is:

c:\Program Files\Tiera Software\Defect Manager Release

460.
4.

If you did not install in the default location on
the c: drive, or you are using SQLServer or
Oracle databases, you will need to edit the
web.xml file in the web\defectmgr.net sub-
directory and make the following changes:
modify line 3 from:

<add
key="DefectManagerFILEDSN"
value = "c:\Program Files\Tiera
Software\Defect Manager Release
460"

to

<add
key="DefectManagerFILEDSN"
value = "fullpathname where you
installed the product />

The second change is to modify line 4.

If you are using Access as the database
repository, then change line 4 from:

<add key="DefectManagerHome"
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value="FILEDSN=c:\Program
Files\Tiera Software\Defect
Manager Release
460\bin\defectmgrwe.dsn"/>

to

<add key="DefectManagerHome"
value="FILEDSN="fullpathname
where you installed the
product\bin \defectmgrwe.dsn"/>

If you are using SQLServer Or Oracle as
the database repository, then change line 4
from:

<add key="DefectManagerHome"
value="FILEDSN=c:\Program
Files\Tiera Software\Defect
Manager Release
460\bin\defectmgrwe.dsn"/>

to
<add key="DefectManagerHome"
value="FILEDSN="fullpathname
where you installed the
product\bin \defectmgr.dsn"/>
Step 9: Setup E-Tech Support
Step Done By Instructions
9. Setup Defect System Defect Manager E-Tech Support, if you will
Manager E-Tech Administrator | be using this interface—you will need to do the
Support Components | or Web following.

Master

1. Using IIS create a virtual directory (any
name that you want) that points to the
\web\etechsupport sub-directory. You will
need to allow read access and scripting.
The default scripting language should be
VBScript not JScript. Make sure you
check the Enable Parent Paths option.
This is the virtual directory that you will
use to run Defect Manager E-Tech
Support.
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2. If you did not install Defect Manager in the
default location on the c: drive you will
need to edit the global.asa in the
web\defectmgr sub-directory and make the
following changes:

Edit line 6 to make sure that the
Session(“<DefectManagerHome>")
points to the Defect Manager home
directory. The home directory by default is:

c:\Program Files\Tiera Software\Defect
Manager Release 460\ attachments.

Edit line 22 to set the FILE DSN that
Defect Manager Web will use to connect to
the repository database. If you are using
Access this would be:

"FILEDSN=C:\Program Files\Tiera Software\Defect
Manager Release 460\bin\defectmgrwe.dsn™

If you are using SQL Server, Oracle,
Sybase, DB2, Ingres or Postgres then the
default would be:

"FILEDSN=C:\Program Files\Tiera Software\Defect
Manager Release 460\bin\defectmgr.dsn"

Step 10: Install E-Mail Manager Service

Step Done By Instructions

10. Install the System Run MailManagerServicelnstall.bat file located
E-Mail Manger Administrator | in the \bin folder. By default this would be:
Service c:\Program Files\Tiera Software\Defect Manager

Release 460\bin\MailManagerServicelnstall.bat
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